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Are you a beginner at Excel and looking to learn quickly with effective information?Are you ready
to get a great job through learning Microsoft Excel?Are you looking for something that will
change your life for the better?If the answers are YES, keep reading because this guide is
perfect for you!This book will help you to perform better at work and make use of the productive
time you can save. You can cut down on time by using Excel functions such as IF, VLOOKUP, or
COUNTIF.You don’t need any prior experience with Excel to make the most out of it because this
book will show you everything that you need to know.Learn to master Excel functions and work
with charts, tables, navigation, data consolidation and analysis and more in this unique book.In
this manual, you will discover:Learn how to Use Excel with incredible ease thanks to a dedicated
chapter that will teach you incredibly handy functions and formulas to automate your
spreadsheets and create various working solutions, and to provide more value and productivity
into your daily tasks.You will be able to use pivot tables in less than half the time it takes most of
your peers and feel a sense of achievement. You will also realize how you can uncover valuable
insights that can make or break a project or business plan, kind of like how a magician reveals
how he did his magic trick. Few will appreciate how easy it is once they know the secret.Learn
the primary functions of the formula function in Excel including addition, subtraction,
multiplication, and division.Save countless hours, months, and years (yes years!) of frustration.
It’s like having your own personal tutor on call 24/7. And with easy-to-follow step-by-step
instructions that teach you how to master each element that can sometimes stump you!… &
Much More!The manual “Excel 2021” is composed of easy languageand brief explanations of
Excel, intended so that beginners can find answers to the most basic questions in a simple
language.This manual will be your indispensable companion on the journey to
proficiency.Everything you need to know is here, whether you are venturing into the spreadsheet
world for the first time or whether you are upgrading from one of the previous versions of
Excel.What are you waiting for?Order Your Copy NOW and Start mastering Excel 2021 TODAY!



EXCEL 2021The Most Complete Illustrated Guide To Upgrading From Beginner To Expert in
Microsoft Excel. Discover All the Tricks and Hidden Secrets No One Has Ever Told in Only 5
Days!Richard Tudor© Copyright 2022 - All rights reserved. -Jeremy RichardsThe content
contained within this book may not be reproduced, duplicated or transmitted without direct
written permission from the author or the publisher. Under no circumstances will any blame or
legal responsibility be held against the publisher, or author, for any damages, reparation, or
monetary loss due to the information contained within this book. Either directly or indirectly.Legal
Notice:This book is copyright protected. This book is only for personal use. You cannot amend,
distribute, sell, use, quote or paraphrase any part, or the content within this book, without the
consent of the author or publisher.Disclaimer Notice:Please note the information contained
within this document is for educational and entertainment purposes only. All effort has been
executed to present accurate, up to date, and reliable, complete information. No warranties of
any kind are declared or implied. Readers acknowledge that the author is not engaging in the
rendering of legal, financial, medical or professional advice. The content within this book has
been derived from various sources. Please consult a licensed professional before attempting
any techniques outlined in this book. By reading this document, the reader agrees that under no
circumstances is the author responsible for any losses, direct or indirect, which are incurred as a
result of the use of information contained within this document, including, but not limited to,
errors, omissions, or inaccuracies.Table of ContentsIntroductionCHAPTER 1: Microsoft Excel
2021 InterfaceThe Title BarRibbon TabsRibbonOffice ButtonQuick Access ToolbarActive
CellName BoxFormula BarVertical and Horizontal Split ControlCHAPTER 2: Getting Started with
Microsoft ExcelHow to Open Microsoft Excel?To Make a New Blank WorkbookHow to Create a
New WorkbookViewing Two Workbooks SimultaneouslyClosing a WorkbookTo Access a
Previously Saved WorkbookTo Pin a WorkbookUsing TemplatesCreating a Workbook from a
TemplatePrinting Your WorkSharing and Exporting WorkbooksInserting worksheetsDeleting
WorksheetsFreezing Worksheet PanesEntering Numbers and Texts in a WorksheetHow to
Remove a WorksheetHow to Handle Cells in a WorksheetMethods of Renaming a
WorksheetUndo and RedoCut, Copy, and PasteCHAPTER 3: Basic Tasks in Entering, Editing,
and Managing Data in ExcelHiding Columns and RowsHow to Copy Text in a CellHow to Create
More Spreadsheets to Build a WorkbookHow to Name Each Spreadsheet that Makes a
WorkbookThe Quick Access Toolbar ExplainedCHAPTER 4: Cell NavigationEnter Data in a
CellEdit a CellData Region Edge NavigationMultiple Cell HighlightingHow to Wrap Texts in a
CellHow to Auto Select Different CellsTo Delete Content within CellsTo Delete CellsTo Drag and
Drop CellsHow to Use Bold and Italics in a CellThe Fill Handle in a CellUnderlining Commas in a
CellHow to Add Borders to a CellHow to Modify the Text Alignment of Your Border in CellsCell
Selection ExtensionActive Cell NavigationCHAPTER 5: Formulas and FunctionsHow to Make a
Formula in Excel?Building Basic FormulasIF FunctionExcel Sum FormulaExcel Subtraction



FormulaExcel Formulas: Multiplication and DivisionExcel Formulas with Logical OperatorsExcel
Math FormulasText FormulasThe Function Sum ()Excel Operator Order PrecedenceConditional
FunctionsText FunctionsExcel LET FunctionCHAPTER 6: Excel Pivot TablesAdd a Pivot
TableCreating the Pivot TableInsert SlicerLabel FilterChanging the Report's
PerspectiveChanging the Pivot Table's FormatCreating a Pivot Table ChartFormatting a Pivot
Table ChartHow to Filter a Pivot Table in ExcelHow to Use an AutoFilter in ExcelRefreshing
Excel Pivot Table ObjectsHow to Combine Excel VLOOKUP() and PivotTable for Simple
SolutionsCombo SolutionCHAPTER 7: Excel ChartsHistogram Chart and PlottingHow to Make a
Map DiagramScatter ChartRadar ChartWaterfall DiagramColumn ChartHow to Create Pie Chart
in ExcelLine ChartsCHAPTER 8: Common Tools Used in ExcelSorting DataFiltering DataData
CleaningGetting Rid of DuplicatesData Validation FunctioningCHAPTER 9: Getting Help in
ExcelCHAPTER 10: How Data can be Entered in a Workbook?Comment in ExcelTo change the
column widthTo modify all columns or rowsCHAPTER 11: TIPS AND TRICKSConditional
FormattingPaste SpecialMultiple Rows can be addedAbsolute ReferencesPrint
OptimisationExtend Formula Across/DownFlash FillCOMMON PROBLEMS IN EXCEL AND ITS
SOLUTIONSMerged CellsUse as a Text ProcessorVery Complex TablesSeparation
Calculations / ReportCHAPTER 12: Shortcuts, Tips, and Solutions to Common
ProblemsSHORTCUTSBasic Excel ShortcutsGeneral Shortcuts KeysNumber Formatting
Shortcuts KeysWorkbook Shortcuts KeysRibbon Shortcuts KeysDrag and Drop (After Selecting
Cells)Navigation Shortcuts KeysSelection Shortcuts KeysActive Cell Shortcuts KeysFormulas
Shortcuts KeysColumns and Rows Shortcuts KeysPivot Tables Shortcuts KeysDialog Boxes
Shortcuts KeysConclusionIntroductionExcel is a very powerful application that offers countless
opportunities to improve and track the efficiency of our daily tasks. Designed to improve the
storing, analysis, and calculations on large sets of data, Excel has the potential to massively
boost work productivity and efficiency for the knowledgeable user. Data can be effectively
organized and formatted to build clear, effective, and concise reports that will present your
results in a convincing and professional way. The range of tools and functionality available for
statistical analysis is immense, allowing users to tackle very large amounts of data.Microsoft
Excel is a spreadsheet program for managing and organizing numerical and statistical data.
Microsoft Excel includes a variety of tools for performing tasks such as calculations, pivot tables,
graphing tools, macro programming, and more. It works for a variety of operating systems,
including Windows, Mac OS X, Android, and iOS.This book is written to expose you to the
rudiments of excel in an evolving economy where virtually all transactions are based on the
power of the internet. But you cannot handle fiscal transactions accurately without tools such as
Microsoft Excel.Microsoft Excel was originally released on the market in 1987, 32 years ago. It
was built as new software to calculate fundamental end-user functions for individuals searching
for a faster way to compute. Many versions of MS excel have been launched, and the latest one
is Excel 2021, which has highly professional features for high-end businesses and financial
analysts to manage their work more efficiently than ever before. The program grew increasingly



sustainable over time for a variety of reasons. Users will be able to handle massive amounts of
data, create balance sheets, and plan journeys in no time. Microsoft Excel nowadays provides
so much more than that, allowing users to execute a number of spreadsheet-related activities.
Those that open Excel will be able to get started using it right away.To remain competitive in
today's environment, all businesses must adapt and progress. Implementing development
programs so that workers can remain on top of the newest technology and work as effectively as
possible is one approach to remain ahead of the pack and enhance profitability. MS Excel helps
the employees that are talented and desire to be motivated and work hard to remain ahead of
the competition who must have the advanced knowledge of new software and technologies.
Organizations can improve retention and lower employee turnover by giving them the education
and training about the new coming advanced software such as Microsoft Excel to be as efficient
as they want to be. They can also reduce to loss of valuable and the most talented employees to
competitors by offering them ongoing training to be successful. Microsoft Excel for Business is
an application that is often used in these business training programs.Learning basic Excel
shouldn't be an impossible job for you. With this ultimate guide to learn Excel 2021 formulas and
functions step by step from A–Z, you will have wide knowledge in a few hours if you follow all the
instructions we are going to put to learn Excel. Spend a little of your time to finish reading it
completely and you will see how many benefits you will find.Happy Reading.CHAPTER 1:
Microsoft Excel 2021 InterfaceExcel Spreadsheets refers to a rectangular grid with columns and
rows in the Excel user interface. This is how the whole user interface looks:This section provides
an overview of the Excel 2021 user interface so that you’re familiar with the names of various
parts of the interface that will be mentioned throughout the book.The Title BarThe Book1 title
bar is normal (and Book2 etc.). When you save an Excel workbook, these are replaced by the
filename.Worksheet TabA workbook's worksheets Sheet no. 1, Sheet no. 2, and so on are the
default labels. After clicking the worksheet tab, they go to any workbook in the workbook. You
can also navigate using the four small arrows. Tab Arrows is a button to the right of the
worksheet tab. The first arrow will take you to the first worksheet, a second will take you to a
previous worksheet, the third will take you to the next worksheet, and the fourth will take you to
the very last worksheet. By double-clicking on the tab and typing inside a new name, you can
change the name of any worksheet. You can build a new worksheet by selecting that rightmost
workbook button icon, Current Worksheet Button Icon. By left-clicking on the workbook section
and dragging this to a new location in the list, you can rearrange the spreadsheets in the folder.
Through right-clicking on certain worksheet tabs or even the worksheet tab arrows, you can
access additional features.Ribbon TabsThe items throughout the upper menu are called Ribbon
Tabs. Home-Insert, Page Layout-Formula/, etc., are included in the example above. Depending
on whether you're in life, your options can change. The majority of Excel's functionality can be
accessed using this form of ribbon tab. A different ribbon represents each tab. This tab gives you
access to one of Excel's often useful functions. The items throughout the upper menu are called
Ribbon Tabs. Home/Insert/Page/Layout/Formula, and so on are included in the example above.



Depending on whether you're in life, your options can change. A majority of Excel's functionality
can be accessed using this form of ribbon tab. A different ribbon represents each tab. The It tab
gives you access to one of Excel's well functions.RibbonThe ribbon is a set of Excel features
that lead to a single ribbon tab. The Clipboard/ Font/Number/Alignment and other sections of the
Home ribbon are shown in Figure 1. Each group has a number of icons that correspond to Excel
functions. Select the text and then the center indicator Excel Center Script Icon from the
Alignment group on the Home ribbon to center the cell's material inside a worksheet. The
abbreviation for this sequence of steps is: just at the top of the page, you'll find Alignment|
Center.Similarly, you may merge two cell types by going to Home > Alignment|Merge and Center
and highlighting the two cells; both cells will be combined, as well as any content put throughout
the merged cell will be oriented. You can also attach, delete, and format cells, rows, columns,
and worksheets from Home > Cells.There are shortcuts for certain icons. To center the contents
of a cell, for example, click on it and then press Ctrl-E.To learn more about a symbol, hover the
mouse cursor over it (without clicking). A tooltip with information about the icon will appear.On a
ribbon, small arrows emerge next to any group's name (to the right of the title of the piece).
When you press this arrow, a dialogue box will appear with many options for you to choose from.
User clicks the arrow again for Font category on the Home ribbon, for example, opens the
dialogue box of tabs labeled Numbers, Position, Font, Border, etc. Each tab inside the dialogue
box displays a different set of editing features for the cells inside the currently selected
worksheet. Select the Number tab, therefore the Number preference, and then filled in 3 within
the boxes specifying the number of decimal places to display numbers within highlighted cells
with three decimal places.Within a group, faint downward arrows appear next to unique icons.
When you click on the arrow, a vertical variety of options will appear. Clicking the Insert icon in
the Home Ribbon’s Cells tab, for example, displays the choices Insert Cells..., Insert Sheets
Rows, Insert Sheet Column, and Insert Sheet.In certain classes, there are also scrollable
dropdown lists with such a downward arrow. A scrollable range of available fonts is displayed by
pressing an arrow to the right of a Font dropdown list in the Font community, primarily on the
Home ribbon (Arial, Time New Romans, and so on).Office ButtonWhen you press this button,
you'll be presented with a list of choices. There are buttons for opening, saving, and printing
workbooks, as well as an Excel Options icon. A dialogue box appears when you press this
button, allowing you to adjust various configuration parameters.Quick Access ToolbarThat Quick
Access Toolbar located in the upper hand corner of the page and just to the right of an Office
Button above the File or Home tabs in Excel versions beginning with Excel 2021 contains
frequently used icons. By default, the Save, Repeat or Undo icons are now on the toolbar. To add
or delete icons from a toolbar, click the tiny down arrow at just the right end of the toolbar to
bring up the customization dialogue window.Active CellThis is the cell where you last tapped or
moved the mouse. This cell is highlighted in the show.Name BoxYou can get to another cell by
typing the address of that cell throughout the Name Box by pressing the Enter key.Formula
BarThe Formula Bar displays the contents of the active cell. When it's a formula, the formula is



shown here, while the value of the formula is shown in the cell. You may also click the fx symbol
to the right of the Formula Bar to bring up a dialogue box that will help you find the correct
function and arguments for this formula.Vertical and Horizontal Split ControlUsed to split a
worksheet. Just above the vertical scroll bar is the vertical split control, which is a small
rectangular box. When you turn a control downward, the worksheet's view splits in half, allowing
you to see two separate sections of the worksheet at once. The two sections reunite when you
return the control to its original location, and only one view of a worksheet is shown.The
horizontal splitting control is just to the right of a horizontal scroll bar but functions similarly. The
worksheet monitor splits horizontally into two pieces if you switch control to the left.CHAPTER 2:
Getting Started with Microsoft ExcelThe Microsoft Excel program is a spreadsheet made up of
individual cells that can be used to create functions, calculations, charts, and graphs for
organizing and analyzing large amounts of data and information.Excel performs like a database,
with facts, formulas, and functions arranged into rows (defined by numbers) and columns
(defined by letters) that can be used to execute complex calculations.How to Open Microsoft
Excel? Follow the steps below to open MS Excel on your computer:Click on Start.Then any of
the programs will be accessible.The next move is to open MS Office.Finally, choose MS Excel
from the dropdown menu.Alternatively, you should use the Start button to look for MS Excel in
the open search box.Launching Excel 2021 from Windows 10Go to the Taskbar and right tap on
the Excel button. Press down the Alt-key and left-tap on the Excel menu bar.Now, press down
the Alt-key until the screen under shows up. From the options, you can click on the Yes icon to
open a new instance.Another method is running the application. Tap on the Start menu and click
on Run. Then, fill in Excel.exe/x. After typing these letters, click on the Enter menu. But you can
move to Windows 10. Locate the Start menu and type in Excel.exe/x. After this, press the Enter
bar to launch the software.To Make a New Blank WorkbookClick on the File tab. A backstage
view will be displayed.Choose New, then select Blank Workbook.You'll see a new blank
workbook appear.How to Create a New WorkbookCreating a new workbook from an old
workbook could be done by scrolling to the File menu and tapping on the New icon. Go to the
Templates bar and select New from existing.Scroll to the New from the existing Workbook menu.
Search or browse the folder, drive, or web location where the Workbook you want to open is
located. Tap on the Workbook and select Create New icon.Viewing Two Workbooks
SimultaneouslyIt is possible to view two Workbooks at the same time. Follow these methods to
achieve your goals:Move to the Window group in the View tab and select New window.Tap on
View side by side in the Window group located on the View menu.Select the sheet you want to
compare in each Workbook screen.Then, select Synchronous Scrolling to navigate the two
worksheets simultaneously.Closing a WorkbookYou should close it when you are done with a
workbook to release the space it uses. Other workbooks are expected to stay available. You
close Excel as well as exit the very last open workbook.You will exit a workbook with any of the
options below:Pick File  Close. Click the Close button (X) in the right corner of the title bar of
the browser.Hit Ctrl+F4.Hit Ctrl+W.Whether you have made some changes to the workbook



since it was last updated, Excel will inquire if you would like to restore the modifications to the
workbook before closing.To Access a Previously Saved WorkbookYou'll frequently need to open
a previously saved workbook in addition to making new workbooks. To do this follow the steps
below:Go to Backstage view and select Open.Click Browse. You can also select OneDrive to
access files saved on your OneDrive account.The dialog box "Open" will appear. Click Open
after you've found and selected your workbook.Instead of searching for the file, browse your
Recent Workbooks if you've recently opened the required workbook.To Pin a WorkbookYou can
pin a workbook to a Backstage view for easier access if you work with it frequently.Go to
Backstage view and select Open. Workbooks that you've recently edited will appear.Place your
mouse over the workbook you'd like to pin. Next to the workbook, a pushpin icon will appear.
Click the pushpin icon.The workbook will be saved in the Recent Workbooks section. Simply
click the pushpin icon again to unpin a workbook.Using TemplatesA template is a precomposed
spreadsheet that can be used to make a new workbook easily. Custom formatting and
predefined formulas are common features of templates that can help you save time and effort
when starting a new project.To create a new workbook from a template, follow these steps:To
access the Backstage view, click the File tab.Click New. Below the Blank workbook option, you'll
see several templates.Choose a template to review it.A sample of the template will appear,
along with instructions on how to use the template.To use the chosen template, click Create.The
selected template will appear in a new workbook.You can also use the search bar or browse
templates by category for something more specific.Creating a Workbook from a Template To
build a template-based workbook, find a prototype that seems like it could be doing the job and
tap on the thumbnail. Excel shows a box that includes a bigger version, the template source, and
some extra material. If it still looks nice, press the key Build. If not, tap on one of your arrows to
see information for the next (or previous) design in the list.Clicking the Create button will allow
Excel to import the prototype and then build a new workbook focused on that design. The
operation you perform may vary according to the template. That prototype is specific, but much
of it is self-explanatory. Many workbooks include tailoring. Substitute the details default with your
own.The following Figure shows a workbook built from a blueprint. In some ways, this workbook
requires to be personalized. Once the template is used again, customizing it is more effective
than any workbook generated from the template.A workbook created from a template.Use the
save command for later use of this document. Excel provides a filename based on the prototype
title, so you can choose whatever filename you choose. Using Default TemplatesExcel provides
two types of using the file: the original template for the workbook; this type is being used as the
base for new workbooks. And the default template, which is used as a base for later use while
working with other files.These premade files of templates include formals that can be used while
working with other files. It will help you to save time and work effortlessly.Printing Your WorkThe
“quick print” provides the user with the ability to print the current file fast and effortlessly. One
way to trigger this control is to pick the Print file (which shows the backstage view display pane)
and press the Print button. The Ctrl+P keyboard shortcut will have the same impact as the [Print]



file. Using Ctrl+P to display the backstage view, the emphasis is on the Print button, and you can
only click Enter to print.If you like the concept of printing with one click, take a few moments to
insert a new button into your Quick Access toolbar. Click the down-pointing arrow on the right-
hand side of your Quick Access toolbar and then pick Quick Print from the dropdown column.
Excel attaches the button on Fast Print to the Easy Access Toolbar.Simply click the Fast Print
button to print the latest worksheet, using the same print settings on the currently selected
printer. If a user changes the print settings in the template file, then new settings will be used for
printing; otherwise, the default settings for the print will be used by MS excel.
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J. Mielke, “Learn new skills or update your knowledge. I used Excel a very long time ago, so I
needed a new refresher course for work. This is exactly the type of book I was looking for. The
book opens with the very basics. Then we move onto starter functions (like add, subtract, etc).
There are also more advanced content like pivot tables that are explained in great detail. I am a
visual learner, and I found it especially helpful that there were screengrabs and pictures all along
the way. This allowed me to work seamlessly side by side with the book and follow along. I am
not sure I mastered it all in 5 days like the title suggests I could, but I am still learning and
practicing.”

A D, “Get tricks and hidden secrets. The illustrations that teach you how to use Excel in this book
are great and easy to follow. They give you ways to learn the tricks and some hidden ways that
make operating Excel easier. You can achieve full knowledge in 5 days.”

Amanda Lynn, “Becoming an excel export. If you work in an office and deal with numbers, then
knowing how to use excel is a must. This book will take you from a beginner to a much more
advance user in no time. Learn how to do things like pivot tables, if/then statements, vlookups,
etc. Knowing how to use the logic that is built into excel means that excel can do the heavy
lifting and not you.”

uWizz, “Excel 2021: The Most Complete Illustrated Guide To Upgrading From Beginner To
Expert. Excel 2021: The Most Complete Illustrated Guide To Upgrading From Beginner To
Expert.I've started to read the book today. ..... It is well written and easy to follow. I plan on
working with it myself and then pass it on to one of my Grandkids to read. Most likely this
summer. My Daughter may be able to get some benefit from it also as she has a small business.”

Lisa M Dorris, “Learn how to Excel at Excel 2020. {"videoWidth":0,"videoUrl":"https://m.media-
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Learning Excel is a powerful tool to have. Excel offers a wide range of applications. From
running your home or at your job.The language is easy to understand, step by step approach



and easy to understand.”

Riley, “Excel 2021. This is one of the better guides to Excel I have read. If you are looking to
enhance your Microsoft Excel skills, this book can help. There are various tips to help you do
better with Excel. This book has excellent information to help you brush up on your skills.”

Paula Terrado, “With photos. A guide with photos is super helpful! Using this is even better with
complete information. You will really learn and enjoy using excel now because of this very
effective guide book.”

Vervy, “A course to become super savvy in Excel 2022. I have always dreamed of being able to
use Excel competently but, despite so many books purchased, I have never been able to learn
this wonderful program well. Then I found this book about the 2022 version and everything has
changed because it is a real guide that gradually takes the reader to understand everything from
the basics to the most advanced functions. I am learning a lot and with simplicity, for example
how to automate my spreadsheets to simplify and speed up my work, I am learning to use tables
flawlessly and quickly and every day I discover many new tricks that are totally changing and for
the better the my approach to work. I am happy to have purchased this book and now that I have
it I don't know how I have not had it so far. A purchase that I recommend to everyone”

Valentina, “Perfect for everyone. I recently started to work using excel and this book has helped
me improve a lot. It is ideal for every level: this first section is the basics, then it gets into more
detailed information but everything is well explained and instructions are simple to follow
expecially because there are pictures along the way to help you even more. I couldn't
recommend it more”

barbara doveri, “Very good. I've always wanted to learn Excel and when I saw this book, I bought
it right away. Reading it, my expectations were fulfilled, because it is very well written, very
detailed, full of examples with related images. It is truly a great book and I highly recommend it
to anyone like me who wants to learn Excel.”

Monica, “Excel for beginners and experts. Great handbook, for beginners and expert users.
Many rules and tricks are well explained, and some examples also showed. I found very helpful
the explanations of pivot tables and of formulas, even referred to the last 2022 update.”

Andrea, “Excell 2022. a great help to enter the world of excell understand tricks and steps that
help us to facilitate our work or our free time ... I have found some steps that are really simpler
than I thought”

The book by Lisa Murphy has a rating of  5 out of 4.2. 23 people have provided feedback.
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